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Using the File In Tool

The File In tool loads files that were saved by the File Out tool onto the 
workspace for post-measurement processing. The File In tool reloads 
data in the same file format (see page 13) that was specified when the 
original file was saved. An analysis or display tool can be connected to 
the output of the File In tool.

• “Overview of File In Tool” on page 8

• “Loading a Single Data File” on page 9

• “Loading New Files at Each Run” on page 10

• “File In Data Formats” on page 13

• “Loading & Saving File In Configurations” on page 12

• “Printing the File In Window” on page 13 

  

See Also File Out Tool (see the File Out Tool help volume)

HPLogic Fast Binary File Format (see the File Out Tool help volume)

Main System Help (see the HP 16600A/16700A Logic Analysis System 
help volume)

Glossary of Terms (see page 19) 

NOTE: The HP 16533/34A Digitizing Oscilloscope cannot be connected to the output 
of the File In tool. 
2   



 3



4   



Contents
Using the File In Tool

1 Using the File In Tool

Overview of File In Tool 8

Loading a Single Data File 9

Loading New Files at Each Run 10
Numerically Incremented Filenames 11
Save Consecutive Runs 11

Loading & Saving File In Configurations 12

Printing the File In Window 13
File In Data Formats 13
ASCII File In Format 14

Glossary

Index
 5



Contents
6  



1

Using the File In Tool
7



Chapter 1: Using the File In Tool
Overview of File In Tool
Overview of File In Tool

The following example shows a measurement configuration using both 
the File In and File Out tools. The File In tool connected to the 
Waveform tool (lower configuration) displays files that were saved 
using the File Out tool (upper configuration). Using the File In tool 
allows you to display and post-process data at a later time. The 
sequence of events for the following configuration is as follows.

• An analyzer (Analyzer A) is configured to trigger and capture data.

• The Pattern Filter is configured to filter out unwanted data.

• The remaining data is displayed in the Listing tool.

• The same data is saved to a file using the File Out tool.

• The File In tool reloads the stored file from the File Out tool, and displays 
the data in the Waveform tool. 
8



Chapter 1: Using the File In Tool
Loading a Single Data File
Loading a Single Data File

1. Access the File In menu by right-clicking or double-clicking on its icon in 
the workspace, or use the Navigate menu.

2. Select hard disk or flexible disk as source of the data file.

3. Type the source file path, or use "Browse..." to select a file path in the file 
system.

4. Select Read File. 

The selected file is loaded into the connected display/analysis tools.

  

See Also “Loading New Files at Each Run” on page 10
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Loading New Files at Each Run
Loading New Files at Each Run

You can configure the File In tool to automatically load a new file with 
each consecutive run. Files that are loaded consecutively must have 
filenames that are numerically incremented (see page 11), or that have 
been saved from consecutive runs (see page 11) by the File Out tool 
(see the File Out Tool help volume). 

1. In the File In window, select "Hard Disk" or "Flexible Disk" as the file 
source.

2. Type in the desired path and base filename, or use "Browse" to search the 
file system. Remember, the Save Consecutive Runs option in the File Out 
tool names files by duplicating the base filename and incrementing the 
extension. 

3. Click Automatically read a different file with every run.

4. Set the First number field to the first file you want loaded from the set of 
files. For example, if you have a set of 7 files saved, and you want to start 
loading the third file, set the First number field to 3.

5. Set the Last number field to the last file you want loaded. If you select a 
number that exceeds the highest number of files saved, the file loading 
process will stop at the last saved file.

6. Click Run or Read Next File. The first designated file is loaded into the 
File In tool and becomes available at its output. The data will appear at the 
input of any display or analysis tools that are connected to File In. 
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Chapter 1: Using the File In Tool
Loading New Files at Each Run
Numerically Incremented Filenames

This example shows a manually generated list of files that can be 
loaded using the Automatic File Sequencing. Given a base filename of 
"filename", the following files are loaded, one at each run.

Example

filename.1
filename.2
filename.3
filename.4
filename.5

Save Consecutive Runs

The File Out tool lets you automatically save one file per run for the 
selected number of runs. The First Number field indicates the number 
of the next run to be saved. The Last Number field sets the maximum 
number of runs that are saved. As files are saved, the filename suffix is 
incremented by one. 
This example shows a list of 5 generated files.

Example

databus.1
databus.2
databus.3
databus.4
databus.5
11



Chapter 1: Using the File In Tool
Loading & Saving File In Configurations
Loading & Saving File In Configurations

File In settings are saved to a configuration file along with system 
settings.
See:

• Loading Configuration Files (see the HP 16600A/16700A Logic Analysis 

System help volume)

• Saving Configuration Files (see the HP 16600A/16700A Logic Analysis 

System help volume) 

NOTE: The Load Configuration window can be accessed via File->Load 
Configuration. 
The Save Configuration window can be accessed via File->Save 
Configuration. 
12



Chapter 1: Using the File In Tool
Printing the File In Window
Printing the File In Window

The print window operation lets you print just the File In tool window. 
Use this operation if you want a hard copy or electronic record of 
configurations and data currently displayed in the viewing area of the 
File In window.

NOTE: Only the currently displayed viewing area of the File In window is printed. If 
any data or configuration fields appear off-screen, scroll the desired data or 
configuration fields into the window’s viewing area before printing. 

1. Optional - configure the Print Options (see the HP 16600A/16700A Logic 

Analysis System help volume) if desired. 
Print Options includes print destination, file format type, filename 
autoincrement, and color/b&w; pixel mapping. 

2. In the File In tool menu bar, click File, then select Print This Window. 
The print output will be as configured in the Print Options in step 1. 

See Also Set Up the Printer (see the HP 16600A/16700A Logic Analysis System 
help volume) 

File In Data Formats

The File Out tool saves data in Internal, ASCII, or Fast Binary format. 
Data files saved with the File Out tool retain their original format when 
loaded by the File In tool. You can also load UNIX ASCII data files that 
were generated using UNIX platform tools.

CAUTION: ASCII File In format does not support MS_DOS ASCII file format. For a 
complete description of the ASCII file format supported by the File In tool, see 
ASCII below. 

  

Internal The Internal format is a normalized data type used internally by the 
logic analysis system. Normalized data maintains its time correlation 
13
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Printing the File In Window
and alignment when used within the analyzer tools. The Internal 
format is recommended when used within the analyzer because of its 
fast storage and retrieval speed. Also, symbols you have created are are 
stored with the data.

  

ASCII The ASCII (see page 14) format is a common format for exporting data. 
The ASCII format is recommended if you want to export data to 
external tools such as debuggers or spreadsheets. ASCII format files 
require data conversion and result in comparatively larger files. ASCII 
format is not recommended for use within the analyzer system when 
storage/retrieval speed is an issue.

  

Fast Binary The Fast Binary (see the File Out Tool help volume) data format can 
also be used to export analyzer data for post-processing. The Fast 
Binary data format saves data faster than ASCII, and can be parsed 
using programming tools.

  

NOTE: HP recommends that you save ASCII data in hexadecimal format. 
Hexadecimal format makes most efficient use of the ASCII 8-bit format. Binary 
data storage uses an 8-bit ASCII string to represent each character, thus 
increasing the file size by a factor of 8. 

ASCII File In Format

CAUTION: ASCII (American Standard Code for Information Interchange) File In format 
does not support MS_DOS ASCII file format. MS_DOS carriage returns are 
interpreted as part of the string and confuses the File In tool reader. Only 
UNIX ASCII files are supported correctly. Also, DO NOT include control 
characters anywhere in the label fields. This can cause an unstable logic 
analysis system and a loss of data. 

  The logic analysis system’s ASCII File In format is split up into two 
parts, the Header section and the Data section.
14
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The Header Section

The Header section is everything between the 
"16505_Data_Header_Begin" line and the "16505_Data_Header_End" 
line. The header section basically defines the Logic Analyzer labels and 
their attributes. Each label uses three lines to describe it. 

The first line is the fully qualified label name. When created by a Logic 
Analyzer File Out tool, these are "Frame Number:Slot Number:Machine 
Label:Tool Name:Label Name". The string to the right of the last colon 
is the label name. For customer created UNIX ASCII File In files, this 
can be any colon separated hierarchical string, as long as the last entry 
to the right of the last colon is the desired analyzer label name and the 
same string is used to the left of the last colon for all header entries. 
Example; "My simulator:rev 1:July 28:My Label". By convention, signals 
that are active low are preceded by an "*" in the label field. Example; 
*TTSE.

The second line is the data format. Example; Hex, Decimal, Binary, 
Octal, etc. 

The third line is the number of actual bits in the label field. 

Example of three line Label description: 

Frame 1:Slot A:ADDR BUS:*TTSE
Hex                                     
2

There is a special header format for including time information 
between stored states. The label MUST be "Time" (without a colon 
separated hierarchical name), the format MUST be "Absolute-
picoseconds", the number of bits is ignored and hard coded internally 
to 64. Make sure 64 appears there. 

Example of three line Time description: 

Time
Absolute-picoseconds
64

There is a special header format for including state count between 
stored states. The label MUST have the same colon separated 
hierarchical name and end with ":State Counts", the format may be 
either "Absolute" or "Relative", the number of bits MUST be 32.
15
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Example of three line State Count description: 

Frame 1:Slot A:ADDR BUS:State Counts
Absolute
32

It is not required that both State Counts and Time are present. They 
are shown here only for an example of their format. However, since 
time information is valuable, it is recommended that the Time label be 
included at a minimum.

The Data Section

The DATA section comes immediately after the Header section. It 
consists of the ASCII representation of the data in the format specified 
in the header section. Each line corresponds to one logic analyzer 
acquisition storage state. The values are separated by a "space" not a 
"tab". 

Data values for "Time" MUST be in decimal format and MUST 
INCREASE monotonically. The interpretation is each state is assigned 
the time in absolute picoseconds from the trigger. The value must be 
followed by a space and the letters "ps". Example; 32000 ps.

Data values for "State Counts" MUST be in decimal format. If the 
format is "Absolute" the interpretation is each stored state occurred 
that number of state counts from the trigger. If the format is "Relative" 
the interpretation is the current stored state occurred that many states 
after the previous stored state.

Example

16505_Data_Header_Begin
Frame 1:Slot A:ADDR BUS:TDIO
Hex                                     
16
Frame 1:Slot A:ADDR BUS:*TTSE
Hex                                     
2
Frame 1:Slot A:ADDR BUS:TEVT
Hex                                     
1
Frame 1:Slot A:ADDR BUS:TCKO
Hex                                     
1
Frame 1:Slot A:ADDR BUS:*TAAR
Hex                                     
1
Frame 1:Slot A:ADDR BUS:State Counts
Absolute
32
Time
16
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Absolute-picoseconds
64
16505_Data_Header_End
0000 0 0 1 0 1 100000 ps
FFFF 3 1 0 1 2 200000 ps
AAAA 1 0 1 0 3 300000 ps
5555 2 1 0 1 4 400000 ps
0000 0 0 1 0 5 500000 ps
FFFF 3 1 0 1 6 600000 ps
AAAA 1 0 1 0 7 700000 ps
5555 2 1 0 1 8 800000 ps
0000 0 0 1 0 9 900000 ps
FFFF 3 1 0 1 10 1000000 ps
AAAA 1 0 1 0 11 1100000 ps
5555 2 1 0 1 12 1200000 ps

Shown below is how a simple trace list might look based on this 
example data.

TDIO   *TTSE   TEVT   TCKO   *TAAR   State Count     Time
----   -----   ----   ----   -----   -----------   ---------
0000      0      0      1       0        1         100000 ps
FFFF      3      1      0       1        2         200000 ps
AAAA      1      0      1       0        3         300000 ps
5555      2      1      0       1        4         400000 ps
0000      0      0      1       0        5         500000 ps
FFFF      3      1      0       1        6         600000 ps
AAAA      1      0      1       0        7         700000 ps
5555      2      1      0       1        8         800000 ps
0000      0      0      1       0        9         900000 ps
FFFF      3      1      0       1        10        1000000 ps
AAAA      1      0      1       0        11        1100000 ps
5555      2      1      0       1        12        1200000 ps
17
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Glossary
absolute  Denotes the time period 
or count of states between a captured 
state and the trigger state. An 
absolute count of -10 indicates the 
state was captured ten states before 
the trigger state was captured.

acquisition  Denotes one complete 
cycle of data gathering by a 
measurement module. For example, 
if you are using an analyzer with 
128K memory depth, one complete 
acquisition will capture and store 
128K states in acquisition memory.

analysis probe  A probe connected 
to the target microprocessor. It 
provides an interface between the 
signals of the target microprocessor 
and the inputs of the logic analyzer. 
Also called a "preprocessor".

analyzer 1  In a logic analyzer with 
two machines, refers to the machine 
that is on by default. The default 
name is Analyzer<N>, where N is 
the slot letter.

analyzer 2  In a logic analyzer with 
two machines, refers to the machine 
that is off by default. The default 
name is Analyzer<N2>, where N is 
the slot letter.

arming  An instrument tool must be 
armed before it can search for its 
trigger condition. Typically, 
 

instruments are armed immediately 
when Run or Group Run is selected. 
You can set up one instrument to arm 
another using the Intermodule 

Window. In these setups, the second 
instrument cannot search for its 
trigger condition until it receives the 
arming signal from the first 
instrument. In some analyzer 
instruments, you can set up one 
analyzer machine to arm the other 
analyzer machine in the Trigger 

Window. 

asterisk (*)  See edge terms, 
glitch, and labels.

bits  Bits represent the physical logic 
analyzer channels. A bit is a channel 
that has or can be assigned to a label. 
A bit is also a position in a label.

card  This refers to a single 
instrument intended for use in the 
HP 16600A-series or HP 16700A 
mainframe. One card fills one slot in 
the mainframe. A module may 
comprise a single card or multiple 
cards cabled together.

channel  The entire signal path from 
the probe tip, through the cable and 
module, up to the label grouping. 

click  To click an item, position the 
cursor over the item. Then quickly 
press and release the left mouse 
19



Glossary
button.

clock channel  A logic analyzer 
channel that can be used to carry the 
clock signal. When it is not needed 
for clock signals, it can be used as a 
data channel, except in the 
HP 16517A.

context record  A context record is 
a small segment of analyzer memory 
that stores an event of interest along 
with the states that immediately 
preceded it and the states that 
immediately followed it.

context store  If your analyzer can 
perform context store 
measurements, you will see a button 
labeled Context Store under the 
Trigger tab. Typical context store 
measurements are used to capture 
writes to a variable or calls to a 
subroutine, along with the activity 
preceding and following the events. A 
context store measurement divides 
analyzer memory into a series of 
context records. If you have a 64K 
analyzer memory and select a 16-
state context, the analyzer memory is 
divided into 4K 16-state context 
records. If you have a 64K analyzer 
memory and select a 64-state 
context, the analyzer memory will be 
divided into 1K 64-state records.

count  The count function records 
20
periods of time or numbers of state 
transactions between states stored in 
memory. You can set up the analyzer 
count function to count occurrences 
of a selected event during the trace, 
such as counting how many times a 
variable is read between each of the 
writes to the variable. The analyzer 
can also be set up to count elapsed 
time, such as counting the time spent 
executing within a particular function 
during a run of your target program.

cross triggering  Using intermodule 
capabilities to have measurement 
modules trigger each other. For 
example, you can have an external 
instrument arm a logic analyzer, 
which subsequently triggers an 
oscilloscope when it finds the trigger 
state.

data channel  A channel that 
carries data. Data channels cannot be 
used to clock logic analyzers.

data field  A data field in the pattern 
generator is the data value associated 
with a single label within a particular 
data vector.

data set  A data set is made up of all 
labels and data stored in memory of 
any single analyzer machine or 
instrument tool. Multiple data sets 
can be displayed together when 
sourced into a single display tool. The 
  



Glossary
Filter tool is used to pass on partial 
data sets to analysis or display tools.

debug mode  See monitor.

delay  The delay function sets the 
horizontal position of the waveform 
on the screen for the oscilloscope and 
timing analyzer. Delay time is 
measured from the trigger point in 
seconds or states.

demo mode  An emulation control 
session which is not connected to a 
real target system. All windows can 
be viewed, but the data displayed is 
simulated. To start demo mode, 
select Start User Session from the 
Emulation Control Interface and 
enter the demo name in the 
Processor Probe LAN Name field. 
Click Help in the Start User Session 
window for details.

deskewing  To cancel or nullify the 
effects of differences between two 
different internal delay paths for a 
signal. Deskewing is normally done 
by routing a single test signal to the 
inputs of two different modules, then 
adjusting the Intermodule Skew so 
that both modules recognize the 
signal at the same time.

don’t care  For terms, a "don’t care" 
means that the state of the signal 
(high or low) is not relevant to the 
 

measurement. The analyzer ignores 
the state of this signal when 
determining whether a match occurs 
on an input label. "Don’t care" signals 
are still sampled and their values can 
be displayed with the rest of the data. 
Don’t cares are represented by the X 
character in numeric values and the 
dot (.) in timing edge specifications.

dot (.)  See edge terms, glitch, 
labels, and don’t care.

double-click  To double-click an 
item, position the cursor over the 
item, and then quickly press and 
release the left mouse button twice.

drag and drop  To drag and drop an 
item, position the cursor over the 
item, and then press and hold the left 

mouse button. While holding the left 
mouse button down, move the mouse 
to drag the item to a new location. 
When the item is positioned where 
you want it, release the mouse 
button.

edge mode  In an oscilloscope, this 
is the trigger mode that causes a 
trigger based on a single channel 
edge, either rising or falling.

edge terms  Logic analyzer trigger 
resources that allow detection of 
transitions on a signal. An edge term 
can be set to detect a rising edge, 
21



Glossary
falling edge, or either edge. Some 
logic analyzers can also detect no 
edge or a glitch on an input signal. 
Edges are specified by selecting 
arrows. The dot (.) ignores the bit. 
The asterisk (*) specifies a glitch on 
the bit. 

emulation module  A module 
within the logic analysis system 
mainframe that provides an 
emulation connection to the debug 
port of a microprocessor. An E5901A 
emulation module is used with a 
target interface module (TIM) or an 
analysis probe. An E5901B emulation 
module is used with an E5900A 
emulation probe.

emulation probe  The stand-alone 
equivalent of an emulation module. 
Most of the tasks which can be 
performed using an emulation 
module can also be performed using 
an emulation probe connected to 
your logic analysis system via a LAN.

emulator  An emulation module or 
an emulation probe.

Ethernet address  See link-level 

address.

events  Events are the things you 
are looking for in your target system. 
In the logic analyzer interface, they 
take a single line. Examples of events 
22
are Label1 = XX and Timer 1 > 400 

ns.

filter expression  The filter 
expression is the logical OR 
combination of all of the filter terms. 
States in your data that match the 
filter expression can be filtered out or 
passed through the Pattern Filter. 

filter term  A variable that you 
define in order to specify which 
states to filter out or pass through. 
Filter terms are logically OR’ed 
together to create the filter 
expression. 

Format  The selections under the 
logic analyzer Format tab tell the 
logic analyzer what data you want to 
collect, such as which channels 
represent buses (labels) and what 
logic threshold your signals use.

frame  The HP 16600A-series or 
HP 16700A logic analysis system 
mainframe. See also logic analysis 

system.

gateway address  An IP address 
entered in integer dot notation. The 
default gateway address is 0.0.0.0, 
which allows all connections on the 
local network or subnet. If 
connections are to be made across 
networks or subnets, this address 
must be set to the address of the 
  



Glossary
gateway machine.

glitch  A glitch occurs when two or 
more transitions cross the logic 
threshold between consecutive 
timing analyzer samples. You can 
specify glitch detection by choosing 
the asterisk (*) for edge terms under 
the timing analyzer Trigger tab.

grouped event  A grouped event is 
a list of events that you have 
grouped, and optionally named. It can 
be reused in other trigger sequence 
levels. Only available in HP 16715A, 
16716A, and 16717A logic analyzers.

held value  A value that is held until 
the next sample. A held value can 
exist in multiple data sets.

immediate mode  In an 
oscilloscope, the trigger mode that 
does not require a specific trigger 
condition such as an edge or a 
pattern. Use immediate mode when 
the oscilloscope is armed by another 
instrument.

interconnect cable  Short name for 
module/probe interconnect cable.

intermodule  Intermodule is a term 
used when multiple instrument tools 
are connected together for the 
purpose of one instrument arming 
another. In such a configuration, an 
 

arming tree is developed and the 
group run function is designated to 
start all instrument tools. Multiple 
instrument configurations are done in 
the Intermodule window.

intermodule bus  The intermodule 
bus (IMB) is a bus in the frame that 
allows the measurement modules to 
communicate with each other. Using 
the IMB, you can set up one 
instrument to arm another. Data 
acquired by instruments using the 
IMB is time-correlated.

internet address  Also called 
Internet Protocol address or IP 
address. A 32-bit network address. It 
is usually represented as decimal 
numbers separated by periods; for 
example, 192.35.12.6. Ask your LAN 
administrator if you need an internet 
address.

labels  Labels are used to group and 
identify logic analyzer channels. A 
label consists of a name and an 
associated bit or group of bits. Labels 
are created in the Format tab. 

line numbers  A line number (Line 
#s) is a special use of symbols. Line 
numbers represent lines in your 
source file, typically lines that have 
no unique symbols defined to 
represent them. 
23
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link-level address  Also referred to 
as the Ethernet address, this is the 
unique address of the LAN interface. 
This value is set at the factory and 
cannot be changed. The link-level 
address of a particular piece of 
equipment is often printed on a label 
above the LAN connector. An 
example of a link-level address in 
hexadecimal: 0800090012AB.

local session  A local session is 
when you run the logic analysis 
system using the local display 
connected to the product hardware. 

logic analysis system  The 
HP 16600A-series or HP 16700A 
mainframe, and all tools designed to 
work with it. Usually used to mean 
the specific system and tools you are 
working with right now.

machine  Some logic analyzers allow 
you to set up two measurements at 
the same time. Each measurement is 
handled by a different machine. This 
is represented in the Workspace 
window by two icons, differentiated 
by a 1 and a 2 in the upper right-hand 
corner of the icon. Logic analyzer 
resources such as pods and trigger 
terms cannot be shared by the 
machines.

markers  Markers are the green and 
yellow lines in the display that are 
24
labeled x, o, G1, and G2. Use them to 
measure time intervals or sample 
intervals. Markers are assigned to 
patterns in order to find patterns or 
track sequences of states in the data. 
The x and o markers are local to the 
immediate display, while G1 and G2 
are global between time correlated 
displays.

master card  In a module, the 
master card controls the data 
acquisition or output. The logic 
analysis system references the 
module by the slot in which the 
master card is plugged. For example, 
a 5-card HP 16555D would be 
referred to as Slot C: machine 
because the master card is in slot C of 
the mainframe. The other cards of 
the module are called expansion 

cards.

menu bar  The menu bar is located 
at the top of all windows. Use it to 
select File operations, tool or system 
Options, and tool or system level 
Help.

message bar  The message bar 
displays mouse button functions for 
the window area or field directly 
beneath the mouse cursor. Use the 
mouse and message bar together to 
prompt yourself to functions and 
shortcuts.
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module  An instrument that uses a 
single timebase in its operation. 
Modules can have from one to five 
cards functioning as a single 
instrument. When a module has more 
than one card, system window will 
show the instrument icon in the slot 
of the master card.

module/probe interconnect cable  

The module/probe interconnect cable 
connects an E5901B emulation 
module to an E5900B emulation 
probe. It provides power and a serial 
connection. A LAN connection is also 
required to use the emulation probe.

monitor  When using the Emulation 
Control Interface, running the 
monitor means the processor is in 
debug mode (that is, executing the 
debug exception) instead of 
executing the user program.

panning  The action of moving the 
waveform along the timebase by 
varying the delay value in the Delay 
field. This action allows you to 
control the portion of acquisition 
memory that will be displayed on the 
screen. 

pattern mode  In an oscilloscope, 
the trigger mode that allows you to 
set the oscilloscope to trigger on a 
specified combination of input signal 
 

levels.

pattern terms  Logic analyzer 
resources that represent single states 
to be found on labeled sets of bits; for 
example, an address on the address 
bus or a status on the status lines. 

period (.)  See edge terms, glitch, 
labels, and don’t care.

pod  See pod pair

pod pair  A group of two pods 
containing 16 channels each, used to 
physically connect data and clock 
signals from the unit under test to the 
analyzer. Pods are assigned by pairs 
in the analyzer interface. The number 
of pod pairs avalaible is determined 
by the channel width of the 
instrument.

point  To point to an item, move the 
mouse cursor over the item.

preprocessor  See analysis probe.

primary branch  The primary 
branch is indicated in the Trigger 

sequence step dialog box as either 
the Then find or Trigger on 
selection. The destination of the 
primary branch is always the next 
state in the sequence, except for the 
HP 16517A. The primary branch has 
an optional occurrence count field 
25
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that can be used to count a number of 
occurrences of the branch condition. 
See also secondary branch.

probe  A device to connect the 
various instruments of the logic 
analysis system to the target system. 
There are many types of probes and 
the one you should use depends on 
the instrument and your data 
requirements. As a verb, "to probe" 
means to attach a probe to the target 
system.

processor probe  See emulation 

probe.

range terms  Logic analyzer 
resources that represent ranges of 
values to be found on labeled sets of 
bits. For example, range terms could 
identify a range of addresses to be 
found on the address bus or a range 
of data values to be found on the data 
bus. In the trigger sequence, range 
terms are considered to be true when 
any value within the range occurs.

relative  Denotes time period or 
count of states between the current 
state and the previous state. 

remote display  A remote display is 
a display other than the one 
connected to the product hardware. 
Remote displays must be identified to 
the network through an address 
26
location.

remote session  A remote session is 
when you run the logic analyzer using 
a display that is located away from 
the product hardware. 

right-click  To right-click an item, 
position the cursor over the item, and 
then quickly press and release the 
right mouse button.

sample  A data sample is a portion of 
a data set, sometimes just one point. 
When an instrument samples the 
target system, it is taking a single 
measurement as part of its data 
acquisition cycle.

Sampling  Use the selections under 
the logic analyzer Sampling tab to tell 
the logic analyzer how you want to 
make measurements, such as State 
vs. Timing.

secondary branch  The secondary 
branch is indicated in the Trigger 

sequence step dialog box as the Else 

on selection. The destination of the 
secondary branch can be specified as 
any other active sequence state. See 
also primary branch.

session  A session begins when you 
start a local session or remote 

session from the session manager, 
and ends when you select Exit from 
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the main window. Exiting a session 
returns all tools to their initial 
configurations.

skew  Skew is the difference in 
channel delays between 
measurement channels. Typically, 
skew between modules is caused by 
differences in designs of 
measurement channels, and 
differences in characteristics of the 
electronic components within those 
channels. You should adjust 
measurement modules to eliminate 
as much skew as possible so that it 
does not affect the accuracy of your 
measurements.

state measurement  In a state 
measurement, the logic analyzer is 
clocked by a signal from the system 
under test. Each time the clock signal 
becomes valid, the analyzer samples 
data from the system under test. 
Since the analyzer is clocked by the 
system, state measurements are 
synchronous with the test system. 

store qualification  Store 
qualification is only available in a 
state measurement, not timing 

measurements. Store qualification 
allows you to specify the type of 
information (all samples, no samples, 
or selected states) to be stored in 
memory. Use store qualification to 
prevent memory from being filled 
 

with unwanted activity such as no-
ops or wait-loops. To set up store 
qualification, use the While storing 
field in a logic analyzer trigger 
sequence dialog.

subnet mask  A subnet mask blocks 
out part of an IP address so that the 
networking software can determine 
whether the destination host is on a 
local or remote network. It is usually 
represented as decimal numbers 
separated by periods; for example, 
255.255.255.0. Ask your LAN 
administrator if you need a the 
subnet mask for your network.

symbols  Symbols represent 
patterns and ranges of values found 
on labeled sets of bits. Two kinds of 
symbols are available: 

• Object file symbols - Symbols 
from your source code, and 
symbols generated by your 
compiler. Object file symbols may 
represent global variables, 
functions, labels, and source line 
numbers. 

• User-defined symbols - Symbols 
you create. 

Symbols can be used as pattern and 
range terms for: 

• Searches in the listing display.
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• Triggering in logic analyzers and 
in the source correlation trigger 
setup.

• Qualifying data in the filter tool 
and system performance analysis 
tool set. 

system administrator  The system 
administrator is a person who 
manages your system, taking care of 
such tasks as adding peripheral 
devices, adding new users, and doing 
system backup. In general, the 
system administrator is the person 
you go to with questions about 
implementing your software.

target system  The system under 
test, which contains the 
microprocessor you are probing.

terms  Terms are variables that can 
be used in trigger sequences. A term 
can be a single value on a label or set 
of labels, any value within a range of 
values on a label or set of labels, or a 
glitch or edge transition on bits 
within a label or set of labels.

TIM  A TIM (Target Interface 
Module) makes connections between 
the cable from the emulation module 
or emulation probe and the cable to 
the debug port on the system under 
test. 
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timer terms  Logic analyzer 
resources that are used to measure 
the time the trigger sequence 
remains within one sequence step, or 
a set of sequence steps. Timers can 
be used to detect when a condition 
lasts too long or not long enough. 
They can be used to measure pulse 
duration, or duration of a wait loop. A 
single timer term can be used to 
delay trigger until a period of time 
after detection of a significant event. 

time-correlated  Time correlated 
measurements are measurements 
involving more than one instrument 
in which all instruments have a 
common time or trigger reference.

timing measurement  In a timing 
measurement, the logic analyzer 
samples data at regular intervals 
according to a clock signal internal to 
the timing analyzer. Since the 
analyzer is clocked by a signal that is 
not related to the system under test, 
timing measurements capture traces 
of electrical activity over time. These 
measurements are asynchronous 
with the test system. 

tools  A tool is a stand-alone piece of 
functionality. A tool can be an 
instrument that acquires data, a 
display for viewing data, or a post-
processing analysis helper. Tools are 
represented as icons in the main 
  



Glossary
window of the interface. 

toolbox  The Toolbox is located on 
the left side of the main window. It is 
used to display the available 
hardware and software tools. As you 
add new tools to your system, their 
icons will appear in the Toolbox.

tool icon  Tool icons that appear in 
the workspace are representations of 
the hardware and software tools 
selected from the toolbox. If they are 
placed directly over a current 
measurement, the tools automatically 
connect to that measurement. If they 
are placed on an open area of the 
main window, you must connect them 
to a measurement using the mouse. 

trace  See acquisition.

trigger  Trigger is an event that 
occurs immediately after the 
instrument recognizes a match 
between the incoming data and the 
trigger specification. Once trigger 
occurs, the instrument completes its 
acquisition, including any store 
qualification that may be specified.

trigger sequence  A trigger 
sequence is a sequence of events that 
you specify. The logic analyzer 
compares this sequence with the 
samples it is collecting to determine 
when to trigger.
 

trigger specification  A trigger 
specification is a set of conditions 
that must be true before the 
instrument triggers.

workspace  The workspace is the 
large area under the message bar and 
to the right of the toolbox. The 
workspace is where you place the 
different instrument, display, and 
analysis tools. Once in the workspace, 
the tool icons graphically represent a 
complete picture of the 
measurements.

zooming  In the oscilloscope or 
timing analyzer, to expand and 
contract the waveform along the time 
base by varying the value in the s/Div 
field. This action allows you to select 
specific portions of a particular 
waveform in acquisition memory that 
will be displayed on the screen. You 
can view any portion of the waveform 
record in acquisition memory. 
29
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